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Chapter 1: Guardlog Installation 
 
Guardlog is the software that is used to:  

- Capture patrol data 
- process captured patrol data  
- print reports on your guards activities.  

Guardlog software is installed on one computer and may have multiple 
users, who login and use the software on this computer. 
 
For installation you should have: 

- A Guardlog Instillation CD 
- Docking Station 
- Patrol Points (stickers to identify patrol points – not supplied) 
- Route Tags (keyring tags to identify route tags – not supplied) 
- Guard Tags (keyring tags to identify guard tags – not supplied) 
- Baton (stickers to identify baton’s if more than one per site – not supplied)  

Note: Software can be installed on a PC running Windows XP or a newer 
version of windows. 

Note: The screens displayed may vary from version to 

version, the overall performance and operations are the 
same. 

1.1 We will now look at installing Guardlog software. 

Guardlog software is to be installed on one computer only.  

Close all applications before starting this installation. 

Insert the Guardlog CD into the computer that you wish to install the 
software on. 

Open the CD Drive folder and double click on GuardlogInstall.exe file. 
 

Windows may prompt: 

Do you want to allow this application from an unknown 
publisher to make changes to your device? 
Select: Yes  
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1. The Welcome 
window will open 

2. To initiate the 
installation click on  
Next button 

 

 

 

 

 

 

 
1. Read the user 

agreement. Scroll up 
and down using the 
scroll bar on the right. 

2. Click on the radio 
button   
I Accept……  

3. Click on  
Next button 
to accept agreement 

 

 

 
1. A folder will be added 

to C:\Program 
Files(x86) named 
CapeSoft\Guardlog 

2. Click on  
Next button 

 

 

 

  

2 

1 

2 

3 

2 
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1. Installation summary 
window 

2. Click on  
Next button 

 

 

 

 

 

 

1. Option to go back 
and change 
installation settings 

2. Click on  
Next button 

3. Guardlog will now 
install 

 

 

 

 

 
1. Setup is now 

complete 

2. Click on  
Finish button 

 

 

 

 

 

 

 

  

2 

2 

2 
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1.2 Creating a shortcut icon on your desktop for Guardlog. 

 

1. Click on the 
windows button in 

the bottom left corner 

2. Click on Guardlog 

icon drag and drop 
on your desktop 

 

 

 

 

 
 
1. Double click on the 

Guardlog icon to start 
the program 

 

 

 

 

1.3 Adding a user for Guardlog. 

Double click on Guardlog from your desktop. 

On the initial running of the Guardlog software you will be prompted to 
add a new user. 

 

1. This is the prompt 
screen to Add First 
User  

2. Click on the Next 

button   

 

 
  

2

 
 2 

1

 
 2 

2 
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1. Enter user First 
Name and Last 
Name for user 

2. Enter a Login Code 

Note: Login Code is 

used to login to 
Guardlog the initial 
login password will 
by default be the 
same as the Login 
code. We will look at 
changing password 
later. 

3. Click on Next button 

 
1. You have 

successfully added a 
User 

2. Click on Finish 

button 

 

 

 

 

 

 
1. Login is the  

Login Code you 
entered and 
Password by default 
is the same as the 
Login code (both Bob) 

2. Type in the Login 
and Password, click 
on OK button 

Note: if you add a 
checkmark in 
Remember login this 
could pose a security 
risk. 

 

 

 
 

Note: After the 3rd attempt to login with 

incorrect details, the login window will 
close  

1 

2 

3 

1 

2 

2 
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1. On entering the 
correct password the 
Guardlog software 
will start up with the 
following Splash 
screen 

 

 

The first user created, by default has Supervisor access. 

To continue initial installation, jump ahead to 
Chapter 2. Click on the Arrow to jump ahead. 

The remainder of this chapter can be completed later when 
you need to add additional users for Guardlog.  

1.4 Adding Users 

If you have more than one user that needs to access Guardlog follow the 
steps below to add additional users.  

Only users with supervisor access can add and remove users. 

 

1. Open Security Menu 
and click on Users 

 

 

 
1. The Browse Users 

window opens 

2. Click on Insert 
button to add a user 

 

 

 

  

Andd  

1 

2 

Ch. 2 
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1. Enter user First 
Name and Last 
Name  

2. Enter a Login Code 

Note: Login Code is 

used to login to 
Guardlog the initial 
login password will 
by default be the 
same as the Login 
code. 

3. Work Group is for 
future use 

4. Add user Email 
Address (optional) 

5. Select radio button 
for Level and Initial 
Access 
See descriptions below 

6. Click on OK button 

 

 

 

 

Levels 

Supervisor: Has access to all Guardlog screens including 
administration of users. Initial Access will be greyed out 
when selecting Supervisor.  

Operator: Has access to all Guardlog screens except to the 
administration of users.  
Initial Access: If you change the selection to No Access 
the user will have access to no screens, you will need to 
give permission for each screen they are allowed to view.  
(More on this in Set User Access) 

No Access: This user cannot log on to Guardlog.  
Initial Access will be greyed out for this selection.  
This is used for a user that requires infrequent access. 
Instead of deleting the user when access is not required for 
a period of time, you can change them to No Access 
 

  

1 

2 

4 

5 

6 
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1.5 Editing Users 

Supervisors can edit user profiles. 

You can edit a user profile by changing the user Name, Work Group or 
access Level. 

1. To edit an existing 
user profile. Click on 
the user and then 
click on the Change 
button 

2. To delete an existing 
user. Click on the 
user and then click 
on the  Delete 
button  

 

 
 

  

1.6 Setting User Access 

When a supervisor creates an operator user, they can specify which 
screens the user has access to view. 

Earlier we looked at the following default settings when creating an 
operator user. 

Operator: Has access to all Guardlog screens except to the 
administration of users.  
Initial Access: If you change the selection to No Access 
the user will have access to no screens, you will need to 
give permission for each screen they are allowed to view.  
 

 

1. Open Security Menu 
and click on Set User 
Access 

 

  

1 

1 2 
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1. Set Acces Rights 
window opens 

2. Click on a user name 
and the access for 
the selected user can 
be viewed on the 
right 

3. Only users with 
Operator level are 

viewed in this list 
Supervisiors level by 
default have access to 
all screens 
No Acces level can not 
have access to view any 
screens  

 

4. A list of all the screens are visable to the right. A check mark  indicates access 
to the screen and no check mark indicates no access to the screen 

5. Recall when selecting Level access for Operator you could select Initial access 
to be All Access or No Access 
All Access places a check mark  next to all screens in this list 
No Access removes all check marks next to each screen in this list 
 
If you wish to give access to most of the screens, it is best to set Initial Access to 
All Access. You can then remove the check marks next to the screens you wish 

the operator not to have access to. 
If you wish to give acces to a few screens it is easier to select Initial Access as 
No Access. You can then add a check mark to the few screens you wish to give 
access to. 

1.7 Creating User Groups 

Setting user access could seem like a tedious task, if you have many 
users that you need to give the same access.  

To assist with this, you can create a user group and assign the access 
once to the group. You will then make the user a member of this group.  

 

1. Open Security Menu 
and click on User 
Groups 

  

1 

2 

3 
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1. The User Groups 
window opens 

2. Click on Insert 
button to add a  
User Group 

 

 

 
1. Name the User 

Group a descriptive 

name 

2. Select the Level 

3. If Operator Level 
select Initial Access 

for the User Group 

4. Click on OK button 

5. Close User Groups 

Window 

 

 
1. Open Set Access 

Rights form Security 
menu 

2. You will see you’re 
your new User 
Group is listed here 
with the list of 
Operators 

3. Select the User 
Group and set 

access to screens  

4. These buttons allow 
quick access to the 
User Groups and 
Users windows 

 

 

 

 

  

2 

1 

2 

3 

4 

4 

2 
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1.8 Adding Users to Groups 

You can now add users to your user group. Once a user is added to a 

user group all individual access falls away and they will only have access 
set in the user groups they belong to. 

1. Open Security Menu 
and select Users  

2. You can now see in 
the Users Window to 

the right, the 
available groups and 
which groups the 
selected user 
belongs to.  

3. Select a User and 
then click on Change 
button 

1. Update User window 
opens 

2. Double click on the 
groups you wish the 
user to be part of.  
A user may belong to 
more than one group. 

3. Click on the OK 
button 

When you now open 
Security Menu and 
click on Set User 
Access, you will no 
longer see this user 
listed with the other 
operators. This user 
now will have the 
same access set for 
the User Group/s he 
belongs to  

 

 

 

 

  

2 

3 

2 

3 
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1.9 Changing User  

Once logged into Guardlog you can select to login as a different user. 

1. Open Security Menu 
and click on Change 
Login 

 

 

1. Enter details to 
login to Guardlog as 
different user  

2. Click on the OK 
button 

 

 

 

1.10 Changing User Password 

By default the initial password is the same as the Login Code created for 
the user. Only a user can change their password, a supervisor can only 
change their own password and not the password of other users. 

 

1. User to log in to 
Guardlog. 

2. Open Security Menu 
and click on Change 
Password 

 
1. Type in your Old 

Password and then 
the New Password 
and Verify 
Password 

2. Click on OK button 

3. At the next login you 
will need to use your 
new pasword 

 

 

 
 

2 

1 

2 

1 

1 

2 
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Chapter 2: Registering Guardlog  
 

The initial installation of Guardlog is a demo version. We need to register 
your software.  

Contact CapeSoft and request a “Guardlog product activation code”.  

You will receive an Email from CapeSoft to activate your copy of 
Guardlog. 

 
1. Login to Guardlog 

2. Open Help Menu 
and click on Register 
Product 

1. Register Guardlog 
window opens 

2. Drag and drop the 

registration details file 
from your Email to 
the drag and drop 
box 

 
1. A succesful 

registration window 
opens 

2. Click on  OK button 

3. Alternativley you can 
manually enter 
registration details 
and activation codes 
and then click on the 
Activate Guardlog 
button 

4. Restart Guardlog to 

complete the 
registration 

 

 

 

 

 

 

 

 

2 

2 

2 



 

16 

D

Chapter 3: Installing Docking 

Station  
 
First we need to install the driver for the Docking Station.  

Open the CD Drive folder and double click on folder named  
USB Docking Station Driver, right click on the file and select,  
Run as Administrator. 
 

Windows may prompt: 

Do you want to allow this application from an unknown 
publisher to make changes to your device? 
Select: Yes 

 
1. The FTDI DM Drivers 

window will open 

2. To initiate the 
installation click on  
Extract button 

 

 

 

 

 

 

1. Click on the 
Next button 
 

 

 

2 

2 
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1. Read the user 
agreement. Scroll up 

and down using the 
scroll bar on the right. 

2. Click on the radio 
button   
I Accept…… 

3. Click on  
Next button 

 

 

 

 

1. Setup is now complete 
Click on  
Finish button 

 

 

 

 

 

 

 

Next we will connect the Docking Station to a free USB port on the 
computer and configure the port.  

 

  

1 

2 

3 

1 
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1. This is your Docking 
Station  

 

 

 

 

 

 
1. Plug in the USB 

connector  

 

 

 

2. Into a free USB port 

on your computer 

Note: use a USB 
port with a white 
tongue (USB2.0) 
do not use a USB 
port with a blue 
tongue (USB3.0)  
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The next step is to configure the software to recognise the docking 
station. 

 

1. Login to Guardlog 

2. Select the Settings 
Icon 

 

1. Update Guardlog 
Settings window 

opens on the 
Comms tab 

2. Type in the USB port 

number  

Note: If you are 
unsure of the USB 
port number. This 
could be from port 1 
up to port 8 

3. Type in 1 for Comm 
and click the Test 
button to verify the 
port number 

 

1. If incorrect port has 
been selected you 
will see the following 
message 

2. Click OK button and 
type in 2 for port and 
click the Test button 

again 

 

 

 

 

 

 

 

 

 

 

 

  

2 

3 

2 

1 
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1. On successful port 
selection the 
following message 
will be displayed 

2. Click on the OK 
button to close 

sucessful message 

 

 
1. Click on OK button 

to close the settings 
window 

 

 

 

 

 

 

 

 

 

You have successfully installed the docking station. 

 

Note: if you remove the USB cable and connect the 
docking station to another USB port on your computer. 
You will need to re-configure the Comm port again. 

1 

2 
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Chapter 4: Planning Before 

Configuring 
 
Before configuring your Guardlog System lets discuss the options for 
setup. Various components make up the Guardlog database. 

Sites:  Guardlog supports multiple sites, each site has a number of 
patrol points associated with it. 

Points: Point tags that the guard must tag, are entered with a 
description of each point tag. The associated Site number 
must also be carefully selected. The Point Database is the 
heart of Guardlog. 

Routes: Route is the name given to a specific sequence of points the 
guard must tag. A site can have more than one route. Optional 

Rosters: This is to specify the points to be tagged in a route and the 
order they are to be tagged in. You create a roster for each 
point in the route. Optional 

Officers: Details for each officer that will be on guard for various sites. 
Optional 

We need to setup Sites and Points but Routes, Rosters and Officers 
are optional for setup. It will help to understand what you require from 
Guardlog as a reporting tool to decide what you need to setup. 

Requirements from reports Then set up 

Reports on date and time points are visited Site - Points  

Reports on more than one site that guards 
visit 

Multiple Sites - Points 

Reports if a point has not been tagged a 
predetermined number of times a day 

Site – Points (visit count setup in 
point) 

Reports on different officers  
Reports on multiple batons used 

Site – Points – Officers 

Reports on various routes, officers guard  
Reports on a route followed in sequence 
Reports on points tagged a specific number 
of times in a predetermined time 

Site – Points – routes and rosters 
 
(scheduled visits in roster) 
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You should now have an idea of what you need to configure. 

Before we continue we need to setup what tags will be reported on in the 
database. 

1. Login to Guardlog 

2. Select the Settings 
Icon 

 

1. Update Guardlog 
Settings window 

opens  

2. Select Processing 
tab 

3. Select battons First 
Tag/s Route 
Identification 

 

None: This is used if 
you are only using 
Sites and Points 
 
RouteTag Only: 
Using Sites, Points 
and Routes but no 
Officers setup 
 
Officer Tag Only: 

Using Sites, Points 
and various Officers 
but no Routes setup 
 
Route and Officer 
Tag: Using Sites, 

Points, Routes and 
Officers that have 
been setup 

3. Click on OK button 

 

 

 

 

 

 

 

 

 

 

 

 

  

2 

2 

3 
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Chapter 5: Configuring the 

Guardlog Software 
 
For optimum performance from your Guardlog System, the system must 
be correctly configured. 

 

5.1 Creating a Site  

Guardlog supports multiple sites; each site has a number of patrol points 
associated with it. If the distance between sites is too far to take batons 
for regular download, it is suggested that separate licences for Guardlog 
are run at each site. 

The minimum number of sites to be configured is 1 and the maximum is 
unlimited. 

Example picture of two  
sites, each with their  
own patrol points. 

Site: 
Workshop 1 

Site: 
Workshop 2 
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1. Open Browse Menu 
and click on Sites 

 

 

 

 
1. The Browse Site 

Window opens 

2. Click on Insert button 

to create your 1st site 

 

 

 
1. Allocate a number 

to the site.  

2. Type in a descriptive 
Site name that will 
easily be identified by 
your collegues.  
Max 25 Charactors 

3. Type in a site 
contact number and 
site contact person  

4. Click on the OK 
button 

 

 

 

 

 

 

Continue to add all your required sites. 

 

1 

4 

2 

1 

2 

3 
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5.2 Editing a Site  

1. Here you can see 
that there are 2 sites 
created 

2. To edit an existing 
site, click on the site 
and then click on 
Change button 

3. To delete an existing 
site. Click on the site 
and then click on 
Delete button and 

confirm to delete  

4. Send to button opens 
the Send To… 
window. You can 
select to send to …  

Printer: sends to your 
default printer 

File: Saves as a file, you 

can select PDF, HL, 
Excel, XML, Word or 
CSV format 

Email: as a file to a 

specified Email address, 
you can select PDF, HL, 
Excel, XML, Word or 
CSV format 

FTP: for future use 

Clipboard: you can 

paste the copy clipboard, 
you can select PDF, HL, 
Excel, XML, Word or 
CSV format 

5. Make your section 
and the click on the 
Send button 

 

 

 

 

 

 

 

 

 

 

  

4 2 3 

5 
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5.3 Creating Points 

Points are tags that the guard must tag to confirm they have arrived at a 
specific point, they are created with a description for each point tag. The 
associated Site number must also be carefully selected. The Point 
Database is the heart of Guardlog. 

 
Example picture: two  

sites each with their  
own patrol points. 

 

 

 

One point tag is needed for every point you require the guard to tag. 
Point tags need to be configured on the computer before they are 
installed in each location. 

Look at the face of each point tag, note the Hexadecimal 
number on the face of the point tag. This is the unique 
point tag number for this point tag. 

Example : 0000030AEFD2 

The point tag number is the physical ID number of the point tag, attached 
to a specific location at a site that you require the guard to visit. 

1. Open Browse Menu 
and click on Points 

 

 

 

 
1. Click on Insert button 

to create your 1st 
point tag 

 

 

 

 

1 

Site: 
Workshop 1 

Site: 
Workshop 2 

1 
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Update Point window 
opens 

There are 2 methods to 
create the point tag  

Manually enter the 

hexadecimal number, 
use convert button to 
convert to decimal  

Or use the read head on 
the docking station to 
read the point tag  

We will look at each 
method 

Convert Method 
1. Type the 

hexadecimal 
number without the 

leading zero’s at 
Point Tag No 

2. Click on the Convert 
button, the number 
is converted to a 
decimal number 

3. Supervisor check 
Point If checked, 
specifies that the 
Point is a checkpoint 
that supervisors 
should visit whilst at 
the Site 

4. Point Number will 

automatically use the 
next available free 
number 

5. Enter a description 

of the point location  
Max 35 characters 

6. Select the Site that 
the point is in 
Click on search button to 
see a list of all sites 
created. Double click on 
the site to select 

 

 

 

 

7. Enter the expected number of Visit Counts for 

this point in one day 

8. Click on OK button 

 

 

 
Tip: Add a sticker on the face of the point tag with the 

point number. This will help to identify where you need 
to install each point tag. If you are creating point tags 
for more than one site, use different colours per site to 
avoid mix ups.  

5 

4 

5 

7 

8 

2 

6 
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Read Head Method 

1. Click on Insert button 

to create another 
point tag 

2. Place Point tag on 
the Docking Station  

 

1. Click on Read Point 
Button 

 

 

 

1. Capture a Point or 
Tag window opens 

2. Apply pressure on 
the Point tag to 
ensure contact with 
the Docking Station 

 

1. Point detected and 
converted message 

2. Remove the Point 

from the Docking 
Station and click on 
Accept button 

 

1. Should you receive a 
Family Code Fail  

2. Remove the Point, 
click on the Cancel 
button and start the 
process again 

Once you have accepted 
the converted decimal 
number, continue 
completing the form as 
explained above in the 
Convert Method  

  

 

 

 

 

 

 

 

 

 

 

  

1 

1 

2 

1 

2 

2 
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1. If you add a point tag 
that has been 
captured before, the 
following Duplicate 
Key Error will display 
Click the OK button 

and continue with 
another point tag 

 

A list of all added point 
tags is visible in the 
Browse Points window 

You can select to view 
point tags from a specific 
site  

1. Click on the search 
button to see a list of 
all sites created with 
their descriptions.  

2. Click on the site you 
wish to view and 
click on Select 
button 

 

You will now only be 
viewing points for the 
selected site 

To view all site’s points 
select 0:All Sites 

 

Notice you have: 

Send To button 
Change button 
Delete button 

They work on the same 
principles as seen in  
5.2 Editing a Site  

 

 

 

 

 

 

 

 

 

 

 

 
Points can now be installed in their locations around 
the site. It is important to ensure you are installing the 
point in the correct location as per the description for 
the point when created. 

 
Print a copy of the Browse Points window for your 
Site and with the stickers you added on each point tag 
it will be easy to locate positions for installation.

  

1 

1 

2 
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5.4  Naming Routes (Optional) 

Route is the name given to a specific sequence of points the guard must 
tag. A site can have more than one route. i.e. clockwise route and an 
anti-clockwise route. Each route has a route tag allocated to the route. 

The route tag will be used to identify which route 
the guard will go on, before his patrol starts. A 
route tag needs to be allocated for each route.  

Setting up routes is optional: If you do not 
require guard/s to follow a specific route, you do not have to set up 
routes and rosters.

1. Open Browse Menu 
and click on Routes 

 

 

1. Click on Insert button 
to create your 1st 
route 

 

 

1. To create the decimal 
tag number for your 
route, use the same 
method used to add 
points 

2. Select a site the 

route will be for,  
useing the search 
button 

3. Select route number, 
will automatically use the 
next available free 
number 

4. Type a descriptive 
name for the route  
Max 35 characters 

5. Click on the OK 
button 

 

 

 

 

 

Tip: add a key ring ID to each route tag. 
Write the route definition on this ID tag. 

1 

1 

1 

3 

4 

5 

2 
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Continue to Insert 
remainder routes 

A list of all added routes 
is visible in the Browse 
Routes window 

You can select to view 
only routes for a 
specific site – as you 
have done before using 
the search button 

Notice you have: 

Send To button 
Change button 
Delete button 

They work on the same 
principles as seen in  
5.2 Editing a Site  
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5.5  Creating a Roster  

This is to specify the points to be tagged in a route and the order they 
are to be tagged in. You will create a roster for each point in the route. 

You need to first create a Route before you can create a Roster.  

Setting up rosters are optional: If you do not require guard/s to follow a 
specific route, you do not have to set up routes and rosters 

1. Open Browse Menu 
and click on Rosters 

 

 

 

 

1. Click on Insert button 
to create your 1st 
point in the roster 

 

 

1. Select a route the 
roster will be for,  
Use the search 
button to view all 
routes 

2. Select roster 

number, will 
automatically use the next 
available free number 

3. Type a descriptive 
name for the roster  
Unlimited characters 

4. Select the roster 
type. 
The first point in a route 
will be Start Roster,  
the Last point in a route 
will be End Roster  
and all points inbetween 
will be Middle Rosters 

 

 

 
5. Select Point use the search button to view all 

points for the selected site 

6. Roster Start time and End Time are for future 
used.  

1 

1 

1 

5 

2 

3 

4 
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1. Select Schedule Tab 

 

 

 

 

 

 

 

 

 

 

1. Enter Start Time and 
End Time for each 

day of the week 

2. Enter the Expected 
Events for this point. 

This will be the 
number of times this 
point is to be tagged 
between the Start 
and End times 
This is not linked to 
initial Point visit count 
which records 
number of times a 
point is tagged in a 
day. 

3. Click on OK button 

 
 
 

 

 
 

 
 

In the above example; the starting point must be visited once between 
09:00 and 09:10 if not an Exception will be generated. More about 
exceptions later. 

  

1 
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Add rosters for each 
point in each route 

In the browse roster 
window you can now 

see rosters for 3 routes – 
look at route description 

You can select to view 
rosters for a specific 
route only  

1. Click on the search 
button to see a list of 
all routes created  

2. Click on the route 
you wish to view and 
click on Select 
button 

You will now only be 
viewing rosters for the 
selected route 

To view all rosters select 
0:All Routes 

Notice you have: 

Send To button 
Change button 
Delete button 

They work on the same 
principles as seen in  
5.2 Editing a Site  

1. You can move a 
rosters order for the 
route, by using the 
arrow buttons. Click 

on the roster you 
wish to move and use 
the up or down 
arrows to change its 
position in the route. 
Start should be at the 
top and End at the 

bottom. 
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1 

2 

3 
4 

5 

This is a Site that has 5 points. If you require the 
guard to visit the 5 points in a specific order at pre-
determined times.  

You need to setup a route with 5 rosters in the route. 
You will setup specific times for each point to be 
tagged in the roster. 

Let’s say moving from point 1 through 5 and back 
to point 1 takes 4 hours to complete. The guard 
is required to follow this route twice in his shift. 
We would then create 11 rosters and 
schedules for this route. 

Roster Point Schedule for roster 

Roster 1 Point 1 6:00 6:10 

Roster 2 Point 2 6:50 7:00 

Roster 3 Point 3 7:50 8:00 

Roster 4 Point 4 8:20 8:30 

Roster 5 Point 5 9:00 9:10 

Roster 6 Point 1 10:00 10:10 

Roster 7 Point 2 10:50 11:00 

Roster 8 Point 3 11:50 12:00 

Roster 9 Point 4 12:20 12:30 

Roster 10 Point 5 13:00 13:10 

Roster 11 Point 1 14:00 14:10  Shift end 
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5.6 Creating an Officer (Optional) 

Set up details for each officer that will guard 
various sites. Each Guard will need a Guard Tag.  

Setting up officers is optional: If you do not have 
more than one guard on duty at a time or you do 
not require to report which guard was on duty and tagging points, you do 
not have to set up officers. The guard/s will then not require a guard tag.  

 
1. Open Browse Menu 

and click on Officers 

 

 

 

 
1. Click on Insert button 

to create your 1st 
officer 

 

1. To create a Guard 
tag number, use the 
same method used to 
add points 

2. Type in Guard Name 
and then Guard 
Surname 

3. Select the Site the 

guard will be working 
at. Use the search 
button to view all 
Sites 

4. Type the Company 

the Guard is from 

5. Allocate a number 
for the batton, place 
the baton in the 
batton reader and 
click on the Set 
Baton No button 

 

 

 

 

 

 

1 

3 

1 

1 

2 

2 
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1. The Download Point 
Events window 

opens 
2. Click on the Proceed 

button 

 

1. Once baton 
successfully added 
following screen 
appears 

2. Remove the baton 
from Batton reader 

and click on the 
Proceed Button 

 
1. Click the OK button 

 

 

 

 

 

 

 

You have succesfully 
added your first guard 
officer and allocated a 
batton for them to use. 

 

Create your remainder 
Officers. 

 
If another officer is using 
the same batton you do 
not have to set the 
Batton again. Just set to 
the same Baton No 

 

 

 

 

 
Tip: Add a keyring ID to each guard tag. Write the 
Guard’s name on this ID tag and baton number they 
are set to use.  

  

1 
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5.7 Testing that the Baton transfers patrol data 

We will now complete a test run with the baton. 

1. Tag the route tag that you will be following, on your 
baton. The baton light will change to red when reading a 
tag. 

2. Tag the officer tag on your baton. The baton light will 
change to red when reading a tag. 

3. Now tag the points of the selected route. The baton light 
will change to red when reading a tag.  

 

1. Insert the baton into 
the docking station 

 

 

 

1. Select the Option to 
read in batons data 
Icon 

 

1. The Download Point 
Events window 

opens 

2. Click on the Proceed 
button 

 

1. You will see a 
succesfully added to 
file window 

2. Click on the Close 
button 

3. The batton will 
automatically clear 
data from the baton 
on successful 
download 

 

 

 

  

1 

2 

2 

Clear Baton button is 
used if the baton has 
been used as a teaching 
tool and transactions 
recorded are not required 
for download to database. 
It will clear all transactions 
from the baton and not 
add to the database. 
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1. If an error occurs 
during download the 
following error will be 
seen. Click on 
proceed button to 
restart the download 

 

1. To view the points 
data downloaded. 
Open View Menu 
click Point Events 

 

1. The Browse Point 
Events window 

opens 

2. Check dates from 
and to are for today. 
Confirm start and 
end time is set to 

include the time you 
ran your test run. 

3. The default sort for 
data is by the time 
points where tagged. 
Change the sort 
order by clicking on 
the column headings. 

1. This view is sorted by 
Point number. the + 
indicates ascending 
order. If you click on 
the column heading 
again it will change to 
a – indicating 

descending order. 

Notice the: 
Send To button 

It works on the same 
principles as seen in  
5.2 Editing a Site  

 

 

 

 

 

 

 

 

  

1 

1 

2 

3 

1 



 

40 

D

5.8 Patrolling Sequence when using Routes and Rosters 

The following steps are to be carried out before a Guard Officer starts his 
patrol. 

1. First the guard officer tags the officer tag on the baton. The baton 
light will change to red on successful reading of tag.  

2. Next the guard officer tags the route tag that will be followed, on 
the baton. The baton light will change to red on successful reading 
of tag. 

3. Lastly the guard officer will tag each point on his round/s of the 
selected route. The baton light will change to red on successful 
reading of tag. 

 

 

 

Note guards may tag route first and then officer tag this will 
not create an exception 

It is good practice to download data from batons daily. A 
baton can retain data on 3000 transactions (tags). Once 
download of data from the baton is completed the data is 
automatically cleared from the baton. 
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Chapter 6: Viewing Downloaded 

data 
 

6.1 Viewing Officer Data 

You can view data on guard officers. Such as date and time officer went 
on patrol. Select a date range to view data over multiple days. You can 
select to view all your Officers or just one officer. 

 

1. To view officer data. 
Open View Menu 
click Officer Point 
Events 

 
1. OR Select the 

Officer Icon 

 

 
1. The Browse Officer 

Point Events 
window opens 

2. Set dates from - to 

3. The default sort for 
data is by the time 
the officers tagged in. 
Change the sort 
order by clicking on 
the column headings 

4. To only view entries 
for a specific officer 
Click on the search 
button to see a list of 
all officers.  

5. Click on the officer 

you wish to view and 
click on Select 
button 

 

 

 

 

 

Notice the: 
Send To button 

It works on the same principles as seen in  
5.2 Editing a Site  

 

1 

1 

4 

5 

2 
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6.2 Viewing Point Data 

You can view point data for each time the point was tagged. Such as 
date and time point was tagged. Select a date range to view data over 
multiple days.  

 

1. To view point data. 
Open View Menu 
click Point Events 

 

1. OR Select the Point 
Icon 

 

 
1. The Browse Point 

Events window 
opens 

2. Set dates from – to 
Set time start - end 

3. The default sort for 
data is by the time 
the point was tagged. 
Change the sort 
order by clicking on 
the column headings 

 

Notice the: 
Send To button 

It works on the same 
principles as seen in  
5.2 Editing a Site  
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6.3 Viewing Event Warnings 

Event warnings report on any event that has not happened,  happened 
before or after specified time or out of order. 

Exceptions reported in Even Warnings: 

Exception Event Description 

Early for Roster Guard has tagged point earlier than indicated on 
the roster schedule. 

Late for Roster Guard has tagged point later than indicated on the 
roster schedule. 

Event Outside Roster Guard has tagged a point outside of the tagged 
route. 

Less than Required 
Roster Events 

Guard has not tagged point as often as referred to 
in the roster. Looks at events set up in roster 
schedule. 

More than Required 
Roster Events 

Guard has tagged point more than referred to in 
the roster. Looks at events set up in roster 
schedule. 

No Roster Events 
Found 

A complete route was not carried out by a guard. 

No Daily Events 
Found 

Created if no events for point found. Looks at 
events (visit count) set up when you created 
points. 

Less than required 
Daily Events 

Created if fewer events for point found than 
entered. Looks at events set up when creating 
points. 

More than required 
Daily Events 

Created if more events for point found than 
entered. Looks at events (visit count) set up when 
you created points. 

Route not recorded Officer started a route without tagging the route 
tag. 

Officer not recorded Officer started a route without tagging the officer 
tag. 

Event out of 
sequence 

Point tagged in different order as set up in the 
roster. 
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1. To view Event 
Warnings. Open 
View Menu click 
Event Warnings 

 

1. OR Select the Event 
Warnings Icon 

 

 

 

1. The Browse Event 
Warning window 

opens 

2. Set dates from – to  

3. The default sort for 
data is by the time 
the point was tagged. 
Change the sort 
order by clicking on 
the column headings 

4. To only view entries 
for a specific route 
click on the search 
button to see a list of 

all routes.  

5. Click on the route 

you wish to view and 
click on Select 
button 

 

 

 

 

 

 

 

6. You can select which events you want to see by 
adding or removing the check mark for the various 
events 

 

Notice the: 
Send To button 

It works on the same principles as seen in  
5.2 Editing a Site  
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Chapter 7: Guardlog Email Setup 
 

We will see in the next Chapter: reports that you can email reports from 
the Guardlog database. We will now look at setting up an Email address 
for Guardlog. 

The Guardlog Email address can use an existing Email account on your 
mail server or you can request your IT deparent to create a dedicated 
Email address for Guardlog. In the example below we use a dedicated 
account for Guardlog. 

 

1. Login to Guardlog 

2. Select the Settings 
Icon 

 

1. Update Guardlog 
Settings window 

opens  

2. Select Email 
Settings tab 

3. If you are unsure of 
the SMTP details, 
speak to your IT 
deparent 

4. Type your SMTP 
Server name and 
SMTP Port number 

5. SMTP User is the 

email address 
Guardlog will be 
sending from  

6. SMTP Password is 
the password for the 
above email account 

 

 

 

7. Sender is the default name you wish the sender to 

be viewed as 

8. Organization is your company name 

9. Click on OK button  

7 

2 

2 

4 

6 

8/ 

5 
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Chapter 8: Reports 
 

The Guardlog System offers the user a wide selection of reports. 

Baton Report Reports on a selected baton or all batons. The user is to 
select the date, time and baton for the report. This report will 
show each instance baton/s were tagged on a point including 
the date and time. 

Point Warnings 
(Roster) Summary 
Report 

Reports on every point. The user is to select the dates and 
time for the reporting period. This report will show each 
instance a point was tagged and report on guard, date, time, 
route recorded, guard recorded, out of sequence or point 
missed. 

Point Activity 
Report 

Reports on a selected site’s points or all sites. The user is to 
select the date, time and site for the report. This report will 
show in two hourly intervals the number of times a point has 
been tagged in that interval over the selected dates. 

Points Visited 
Report 

Reports on a selected point or all points. The user is to select 
the date, time and point for the report. This report will show 
each instance point/s were tagged, by which baton including 
the date and time. 

Site Activity Report Reports on all site’s points. The user is to select the dates 
and time for the reporting period. This report will show in two 
hourly intervals the number of points tagged in a site during 
the interval over the selected dates. 

Supervisor Site 
Visit Report 

Reports on officers tagged. The user is to select the dates 
and time for the reporting period. This report will show date 
and time and site officer tagged 

Warnings (Daily) 
Report 

Reports on events exceptions recorded for all site’s points. 
This is the events (visit count) set when creating a point (how 
many tags in a day) and not events set in roster schedule 
(how many tags in the start to finish of the roster point). The 
user is to select date, time and exceptions for the reporting 
period. This report will show date, time and warning 
description for each exception. 

Warnings (Roster) 
Report 

Reports on events exceptions recorded for all site’s points. 
This is the events set when creating events set in a roster 
schedule (how many tags in the start to finish of the roster 
point) and not a point (visit count) (how tags in a day). The 
user is to select date and exceptions for the reporting period. 
This report will show date, time and warning description for 
each exception. 
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1. To view Available 
Reports Select the 
Report Layouts Icon 

 

1. The Browse Browse 
Report Layouts 
window opens 

2. Click on the report 

you wish to view 

3. Click on the Print 
button 

 

 

 

 

 

 

 

 

  

1 

3 
 

2 



 

48 

D

8.1 Baton Report 

Reports on a selected baton or all batons. The user is to select the date, 
time and baton for the report. This report will show each instance baton/s 
were tagged on a point including the date and time. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select the baton 
number you wish to 
report on, 0 reports 
on all battons 

4. Select dates to report 

from and to 

5. Set time to report 
from and to  

6. Click on Start 
button 

7. Click on print button 
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8.2 Point Warnings (Roster) Summary Report 

Reports on every point. The user is to select the dates and time for the reporting 
period. This report will show each instance a point was tagged and report on guard, 
date, time, route recorded, guard recorded, out of sequence or point missed. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select dates to report 

from and to 

4. Set time to report 
from and to  

5. Click on Start 
button 

6. Click on print button 
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8.3 Points Activity Report 

Reports on a selected site’s points or all sites. The user is to select the date, time and 
site for the report. This report will show in two hourly intervals the number of times a 
point has been tagged in that interval over the selected dates. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select the site 
number you wish to 

report on, 0 reports 
on all sites 

4. Select dates to report 

from and to 

5. Set time to report 

from and to  

6. Click on Start 
button 

7. Click on print button 
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8.4 Points Visited Report 

Reports on a selected point or all points. The user is to select the date, time and point 
for the report. This report will show each instance point/s were tagged, by which 
baton including the date and time. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select the point 
number you wish to 
report on, 0 reports 
on all points 

4. Select dates to report 
from and to 

5. Set time to report 
from and to  

6. Click on Start 
button 

7. Click on print button 
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8.5 Site Activity Report 

Reports on all site’s points. The user is to select the dates and time for the reporting 
period. This report will show in two hourly intervals the number of points tagged in a 
site during the interval over the selected dates. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select dates to report 

from and to 

4. Set time to report 
from and to  

5. Click on Start 
button 

6. Click on print button 
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8.6 Supervisor Site Visit Report 

This report is a visit based report, which displays all visits at all Sites by a supervisor. 
The user is to select the dates and time for the reporting period. This report will show 
date and time and site officer tagged. In order for a ‘Supervisor Visit’ to appear in the 
report, the following requirements should be met. 

- Point should be made a ‘Supervisor Checkpoint’ by checking the ‘Supervisor 
Checkpoint’ checkbox in the Point setup. 

- A Supervisor Visit is made by first touching the Supervisors’ Tag, and then the 
Checkpoints’ Tag with the same Recorder. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select dates to report 

from and to 

4. Set time to report 

from and to  

5. Click on Start 
button 

6. Click on print button 
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8.7 Warnings (Daily) Report 

Reports on events exceptions recorded for all site’s points. This is the events (visit 
count) set when creating a point (how many tags in a day) and not events set in 
roster schedule (how many tags in the start to finish of the roster point). The user is 
to select date, time and exceptions for the reporting period. This report will show 
date, time and warning description for each exception. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select exceptions 

you wish to report on 
add a check mark to 
report on and remove 
to remove exception 
from report 

4. Select dates to report 
from and to 

5. Click on Start 
button 

6. Click on print button 
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8.8 Warnings (Roster) Report  

Reports on events exceptions recorded for all site’s points. This is the events set 
when creating events set in a roster schedule (how many tags in the start to finish of 
the roster point) and not a point (visit count) (how tags in a day). The user is to select 
date and exceptions for the reporting period. This report will show date, time and 
warning description for each exception. 

 

1. Notice the: 
Send To options 

2. They work on the 
same principles as 
seen in  
5.2 Editing a Site  

3. Select exceptions 

you wish to report on 
add a check mark to 
report on and remove 
to remove exception 
from report 

4. Select dates to report 
from and to 

5. Click on Start 
button 

6. Click on print button 
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Chapter 9: Setting Up Default 

Printer 
 

This is to setup the default printer that the Guardlog System will  
print to. 

 

1. Login to Guardlog 

2. Open File Menu and 
click on Printer 
Setup 

 

 

1. Printer Setup 
window opens 

2. Click on the drop 
down arrow next to 
printer name and you 
will view all installed 
printers on your 
computer. Click on 
the printer you want 
to be the default.  

3. You can set paper 
settings here 

4. Click on OK button 

 

1. Note:  
File Manager, 
ImportPoint Events 
View Point Events 
File  
are for technicl suport 
to use 
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